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4 Lasernet 10 Changelog 

Introduction. 

This document summarizes the features and fixes included in each 

Lasernet 10 series software release, starting with the most recent. 
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Lasernet 10.10.4. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

458469  Azure 
Storage 

A null object error occurs when adding a local connection to an existing Azure 
Storage Blob command. 

Fixed 

462569  Outlook 
Mail Module 

When using the MailFrom JobInfo in Lasernet, there is an issue with SendOnBehalf 
in the Outlook Mail Output module. 

Fixed 
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Lasernet 10.10.3. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

449582  Azure 
Storage 

Implemented security and performance improvements by updating the Microsoft 
library to the latest version. 

Enhancement 

458482  Azure 
Storage 

The test connection for embedded container and queue connections always 
succeeds, even if wrongly configured. 

Fixed 

457585  Azure 
Storage 

Azure Storage Queue modifiers download the body message in Base64 string 
instead of text. 

Fixed 

458422  Azure 
Storage 

Inserting a message using a modifier changes the job data to base64 so that the 
output file is encoded. 

Fixed 

459528  Scripting Appending a few variations of the values in scripting results in errors. Fixed 

458848  Mail Module The Chilkat library encounters issues due to an expired license. Fixed 

459468  Mail Module Trying to test the connection to IMAP returns an error. Fixed 

456252  Mail Module The race condition causes errors, stating that previous calls to the Chilkat 
unlockBundle have failed. 

Fixed 

458249  Outlook 
Mail Module 

Sending an email on behalf of someone fails to work. 
 

Fixed 
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Lasernet 10.10.2. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

450606  Printer 
Service 

Added support for Shared Access Signature (SAS) authentication with Azure 
Storage. The SAS connection properties can be configured in the Config Server, or 
the Printer Service module and the Printer Service app can read SAS connection 
properties from JobInfos. 

Enhancement  
 

451785  Azure 
Storage 

From Lasernet 10.10, the Azure Storage Input module and the Azure Storage 
modifier could set the following JobInfos. From Lasernet 10.10.2, the Azure Storage 
modifier no longer sets them: 
 

• FullFilename 

• Filename 

• FilenameWithoutExt 

• Extension 

• Filesize 

Enhancement 

451568  Azure 
Storage 

Development Storage functionality for Azure Storage was not supported in Lasernet 
10.10 and later. 

Fixed 

451568 42457 Azure 
Storage 

Inserting a message in the Azure Storage Queue resulted in an encoding error. Fixed 
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Lasernet 10.10.1. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

449098  Azure 
Storage 

Added support for JobInfo substitution in SAS token settings where the JobInfo 
values originate from an incoming job. 
 
This builds on enhancement 446402 added in Lasernet 10.10, which added JobInfo 
substitution in SAS token settings where the JobInfo values are server JobInfos. 

Enhancement  
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Lasernet 10.10. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

439991 40448, 
40758, 
40690, 
40811 

Azure 
Service Bus 
 

Throttling support has been enhanced to improve message handling during heavy 
loads, and a few logger messages have been changed from an error state to a 
debug state. 
 

Enhancement  
 

441293 
 

 Azure 
Storage  
 

Microsoft Entra ID is supported in Azure Storage modules. 
 

Enhancement 
 

446402 
 

 Azure 
Storage 
 

SAS token settings include support for JobInfo Substitution. 
 

Enhancement 
 

443991 
 

41442 
 

Developer  
 

Parallel commits on the same configuration unintentionally remove objects stored as 
resources. 
 

Fixed 
 

446045 
 

 Developer 
 

While adding a new command, the default connection type is no longer set to 
#DatabaseConnection#. 
 

Enhancement  
 

442836 
 

 Form Editor 
 

Opening an XLSX template loads more than the first sheet. 
 

Fixed 
 

446033 
 

41521, 
41706 
 

LnLogin 
 

A VMWare update to the graphics driver 12.5.0.24276846 from 12.4.5.23787635 
causes a crash when using OpenGL. This has been improved so that C:\Program 
Files\Common Files\Formpipe Software\Lasernet 10\AppLauncher\LnLogin.exe -
developer -noopengl can pass the parameter -noopengl to the Lasernet Developer to 
prevent a crash by deactivating the forced OpenGL rendering of graphics in the 
Lasernet Developer. 
 

Enhancement 
 

441757 
 

41003, 
41189  
 

Job Engine  
 

When a user selects all jobs and opts to either release, reschedule, or remove them 
from the Lasernet Client, the Lasernet Server will execute the SQL process using 
multiple commands. Instead of processing all jobs at once, it will release them in 
batches of 50. This approach is intended to prevent the server from encountering the 
error "SAException (NativeCode=-2147217842, Text=Operation was canceled)" 
during periods of heavy load. 
 

Fixed 
 

442792 
 

 Package 
 

Package System.Text.Json 6.0.5, used to parse identifiers for Input Management in 
the Lasernet Client and Lasernet OCR, had a high-severity vulnerability. It has been 
updated to 6.0.10. 
 

Fixed 
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Lasernet 10.9. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

426880 39015 Barcode 
Reader 

Extended the module to support page settings in PDF input. Enhancement 

413182, 
415871 

 Config 
Server 

It is possible to set the Admin user’s permissions to deny them access to the 
Security Roles area. 

Fixed 

429733 39174 Config 
Server 

The Revision column in the Deploy Configuration window is sorted in a random 
order. 

Fixed 

420754  Developer Inactive form thumbnails are not hidden when Toggle hide inactive is selected. Fixed 

420893  Developer Cannot click Cancel in various objects’ Properties window if Name is empty. Fixed 

420812  Developer The column for inactive phrases cannot be sorted. Fixed 

420932  Developer Removed the Mixed item from the Flag dropdown list for form, subforms, and 
phrases (because it was not a supported value). 

Fixed 

435024 40116 Developer Performance issue when Description column is set to auto-resize for a list of forms. Fixed 

429400  Developer The object list filter in the export tool prevents the export of any already-selected 
objects that are hidden because they do not satisfy the filter. 

Fixed 

429963, 
432610 

 Developer Optimized speed when opening a regional profile in a configuration that has many 
regional profiles and forms. 

Enhancement 

420478  Developer An Object does not exist warning appears when a script function is selected 

and properties are changed in the property editor. 

Fixed 

420782  Form Editor A crash occurs when inserting an EMF image from the Choose an image file tool. Fixed 

435599  Form Editor After a drag and drop of an image from the Resources > Image folder, the reference 

to an image object contains the full path instead of the image name. 

Fixed 

437494 40134 Form Editor Escape characters for JSON strings are not correctly parsed. Fixed 

433633 39899 Form Editor If a server-level JobInfo is used in criteria for a rearrange on a subform, that criteria 
is never satisfied. 

Fixed 

435607 40169 Form Editor If the string in a rearrange contains a newline character, and the Font Point Size 
feature is in use, resizing the text box does not auto-change the font size. 

Fixed 

437993 39152 Form Editor Implementation of the substring-before and substring-after XPath functions is 

incorrect. 

Fixed 

434745 40078 Form Editor Some keyboard behaviors in the user interface are incorrect. Fixed 

410273  Form Editor If a change made to a shape style profile is previewed and then the window is 
closed, the change is saved rather than discarded. 

Fixed 

415301 37748, 
37283 

Form Editor Sheets are still combined when the output format of a sheet is changed from EMF to 
(for example) PDF. 

Fixed 

429842  Form Editor Particular XPath expressions that use built-in String functions may return a Boolean 
true instead of an empty string. 

Fixed 

424604 38609 Installer Updated the bundled Microsoft OLE DB Driver 18 for SQL Server from version 
18.6.7 to 18.7.2 due to a possible security vulnerability. 

Fixed 

432418 37315 Outlook 
Mail 

Added support for error codes and reasons when a job fails. Enhancement 
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Internal 
Ref. 

External 
Ref. Area Details Status 

421524 38196 Printer 
Output / 
Printer 
Service 

Added support for printing multiple copies of DOCX and PDF documents as the 
primary job by setting the Copies JobInfo. The feature was previously supported for 

attachments only. 

Enhancement 

424003 38586 XML 
Transformer 
Editor 

An Error executing action message can appear when running a modifier. Fixed 

435466 40172 XML 
Transformer 
Editor 

Expressions such as concat() convert HTML reserved characters within text into 

XML entities. 

Fixed 

423131  XML 
Transformer 
Editor 

The Close Tab context menu item is active when no grab files are loaded. Fixed 

437122 40366 Scripting 
 
Printer 
Service 

Modified getPrinterProfiles() to return printers that have only the Default printer 

profile. 

Enhancement 
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Lasernet 10.8.1. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

432135  SFTP Input Added support for “strict kex extension”. Enhancement 
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Lasernet 10.8. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

408994  Config 
Server 

Fixed an issue that made it possible to remove the system Administrator group. Fixed 

405355  Developer Fixed an issue where the Help > Reset Help menu item did not restore previously 
dismissed help text overlays to the application. 

Fixed 

405613  Developer Fixed an issue where Duplicate was available in the right-click menu for the Master 
server (in the main area of the window when Servers was selected in the Tools 
area). 

Fixed 

405681 
408121 

 Developer Fixed some UI glitches in the Printers and JobInfo tabs of server Properties 
windows. 

Fixed 

408753  Developer Fixed an issue where moving a from destination for a Pass-Through module was not 
possible via drag’n’drop when in diagram mode. 

Fixed 

409844  Developer Fixed a UI issue that caused some profile properties in the Security Profiles area to 
be displayed in the wrong column. 

Fixed 

402438  Engines Fixed an issue where the following engines did not create a new JobID (cloned job) 
after combining only a single job: Compression Engine, JobToXML, 
RichTextConverter, PDF Engine, TIFF Engine, and PDF Merger. 

Fixed 

407867  Form Editor Fixed an issue where the Subform Editor, when in JSON mode, could not be closed 
after a parse error occurred in a template. 

Fixed 

404604  Form 
Engine 

Fixed an issue that caused the Form Engine to use an extensive amount of memory 
when processing batch jobs in text input mode. 

Fixed 

409746  Input 
modules 

Fixed a critical service crash that occurred on Leap Day (29th February during a Leap 
Year) if in Scheduler the Type of Event setting for input modules was Every year. 

Fixed 

409241  OCR Editor 
and Engine 

Fixed an issue where some supported language names in the UI were not presented 
in English for the bundled Dictionary database. 

Fixed 

381739  OneDrive 
Input 

Fixed an issue where the setting of the Case-sensitive regular expression option 
was not saved when the option was selected (set to true). 

Fixed 

381668  Mail Output Fixed an issue where the setting of the Request Delivery Receipt and Request 
Read Receipt options was not always synchronized between the Lasernet 
Developer Properties pane and the Setup tab of the Mail Output Properties 
window. 

Fixed 

413726  XML 
Transformer 
Editor 

Fixed a crash in the XML Transformer Editor if an XPath (used in an action) ended 
with a / (forward slash). 

Fixed 

408762 36463 XML 
Transformer 
Editor 

Added support for using JobInfo substitution in XPaths used in actions (like Lasernet 
9). 

Fixed 
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Lasernet 10.7. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

379079 34463, 
33804 

Config 
Server 

Changed authentication behavior to prevent Lasernet attempting to log a user in as 
an Active Directory Lasernet user if they failed to successfully authenticate as a local 
Lasernet user. Previously, if an Active Directory Lasernet user had the same user 
name as a local Lasernet user, Lasernet tried to “fall back” to the Active Directory 
user in this scenario. 

Fixed 

382724 
399361 

 Config 
Server 

Fixed some sync errors, on the web site, where various fields and icons were not 
updated properly in the UI after renaming a value. 

Fixed 

396903  Config 
Server 

Fixed a security issue where a user without administrative rights was allowed to view 
the history of a configuration. 

Fixed 

390170  Developer After running a module in Test Mode in Lasernet Developer (where the test 
successfully completed and generated output jobs, using grab data pasted into the 
data box), clicking Save to create a grab file from the pasted data and then running 
the module test again did not create any output jobs. 

Fixed 

394835, 
396902, 
396904 

 Developer The Inactive status flag for Form, Subform, and Phrases objects was not shown in 
the Export Object(s) and Import Object(s) dialogs. 

Fixed 

395065  Developer The last hidden/unhidden status of columns was not saved into the Windows 
Registry for all list views. 

Fixed 

401304  Developer The PDF Form Filler engine was displayed in the Forms pane even after it was 
removed from the list of modules. 

Fixed 

399950 36012 Form Editor 
/ Engine 

Barcode objects that represented Swiss QR barcodes were still processed even the 
Object/JobInfo criteria was false. 

Fixed 

393545, 
399178 

36012 Form Editor 
/ Engine 

Fixed an issue with Swiss QR barcodes and the encoding of UTF-8 characters. Fixed 

399024 36303 Job Engine 
/ Service 

Fixed an issue running the XML Transformer and PDF Form Filler modifiers, from a 
modifier event, on the XML Transformer module. 

Fixed 

400917  Monitor app Since December 2023, Microsoft Defender has been flagging the LnMonitor.exe 
software as Trojan:Win32/Znyonm!pz or Phonzy malware. However, this is a "false 
positive", and Microsoft has confirmed that this is the case. 
 
For more information, see https://support.formpipe.com/news/posts/lasernet-monitor-
exe-file-detected-as-malware-by-microsoft-defender 
 
The issue is due to the software that generates the Insights for Performance and 
Transactions charts. To be able to deliver security patches and fixes for our users of 
Lasernet 10, Formpipe Software has decided to exclude the Performance and 
Transactions tabs, and also the functionality embedded in those tabs, from Lasernet 
10.7 to prevent Lasernet Monitor being flagged as malware. 

Support 

397463 36333 OCR Editor Fixed a crash when a language was selected from a Dictionary with multi-languages 
and the selected OCR field didn’t match any words.  

Fixed 

393075  Printer 
Output and 
Printer 
Service 

Added a threshold of 5 mm when detecting the paper format for PDF and DOCX 
documents and supporting auto-selection of paper trays for background printing. This 
will improve the detection of paper sizes that do not follow the standard size for 
paper formats (such as A3, A4, Letter, etc.). 

Improvement 

 

https://support.formpipe.com/news/posts/lasernet-monitor-exe-file-detected-as-malware-by-microsoft-defender
https://support.formpipe.com/news/posts/lasernet-monitor-exe-file-detected-as-malware-by-microsoft-defender
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Lasernet 10.6. 

Maintenance Report

Internal Ref. 
External 
Ref. Area Details Status 

366900 32817 Azure 
Service Bus 

Fixed an issue (in the Azure Service Bus module of Lasernet Developer) where 
entering an invalid SAS Key Name caused Developer to display an empty 
Entity Path dropdown list. 

Fixed 

367043  Azure 
Storage 

Fixed an issue where Developer reported a successful connection if the user 
clicked Test Connection when the Azure Storage connection string was blank. 

Fixed 

375743  Client app Fixed an issue where the Client app hid jobs if the queue name (Formtype) 
contained leading or trailing spaces. 

Fixed 

366266  Developer Fixed an issue moving the pointer for the start and end of destinations in the 
diagram. 

Fixed 

367730 32992 Developer Fixed an issue exporting Database objects whose name contained a dot.  Fixed 

370533 33312 Developer Added validation when renaming forms to prevent illegal characters in form 
names. 

Improvement 

375647 34041 Developer Fixed an issue where the history for all objects was listed instead of only the 
selected object’s history. 

Fixed 

380950  Developer Fixed a crash on attempts to close Lasernet Module Tester. Fixed 

379280  Developer Added HTTP session log to LasernetDeveloper.lnlog for various modules when 
clicking Obtain Authorization or Refresh Access Token. 

Improvement 

382368  Developer Fixed an issue where a text filter on the form list was not reapplied after a form 
was opened and then closed. 

Fixed 

382366  Developer Fixed an issue where Server JobInfo values were no longer present after the 
server settings dialog was opened and then closed.  

Fixed 

388460 35279 Developer Removed unsupported databases from the list of native connection strings. Improvement 

357746 32078 Form 
Engine 

Fixed an issue with resizing of split rearranges in text output. Fixed 

374292 33472 Form 
Engine 

Fixed an issue where empty lines were not removed at the beginning of a 
region. 

Fixed 

369945  Form Editor Fixed a UI issue at the bottom of the Sheet Options dialog. Fixed 

378124 34302 Form Editor Added more items to the Tools menu. Improvement 

377511 34275 Form Editor Fixed that the list of rearranges, in the Pattern and Rearranges dialog, was not 
refreshed for all objects when more than one object was edited. 

Fixed 

381154  Form Editor Fixed an issue where buttons at the bottom of the Edit Barcode dialog were 
enabled when editing the embedded barcode profile. 

Fixed 

387585  Form Editor Fixed a crash when removing an object from a subform and then closing the 
Subform Editor. 

Fixed 

387666 35321 Form Editor If a rearrange on a subform had a value for its Overflow property setting, Form 
Editor did not apply that Overflow setting to the rearrange's text (when 
determining how the content of the subform looked on the forms that used that 
subform). For example, if the rearrange's text was truncated on the subform, it 
was not truncated on the forms that used that subform. 

Fixed 

385723 34758, 
35018, 
35033 

FTP Fixed an access violation in the FTP object, which could cause a crash. Fixed 

368444 33067 Meta app Added MSSQL OLE DB Driver and LocalDB prerequisites to the Meta installer. Fixed 
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Internal Ref. 
External 
Ref. Area Details Status 

375586 34018 Meta Input Added validation to non-editable combo boxes so that functionality intended to 
ensure that the user selects particular list values works. 

Fixed 

369340 33211 OCR 
Engine 

Fixed an error when processing empty pages. Fixed 

375427 33646 Outlook 
Mail and 
OneDrive 

Added support for getting a new access token while throttling. Improvement 

369696 33322 Outlook 
Mail 

Added support for reading child nodes in MIME for incoming mails. Improvement 

386798  Printer 
Input 

Fixed a service crash that occurred if a job was being processed by the Printer 
Input module at the same time as a configuration was being deployed to the 
Lasernet v10 service. 

Fixed 

382733 34810, 
35414 

Printer 
Output and 
Printer 
Service 
App 

Fixed that the scaling mode, when printing PDF documents, by default was not 
set to ActualSize. This caused an unexpected scaling value on the printed 
document. 

Fixed 

371668 33662 Printer 
Service 
module 

Fixed that a job did not fail if a connection to the printer service could not be 
established. 

Fixed 

370908  Tesseract 
OCR 

Fixed an issue where the rotation of PDF documents did not always work. Fixed 

376036  Web Client Fixed an issue where a web page did not load if a row in the Identifiers list for 
an OCR Forms engine contained an empty value for CSVFile. 

Fixed 

387717 35341 Meta 
Installer 

Fixed an issue where the Lasernet EMF printer driver and Lasernet Printer Port 
were missing in the installers, preventing automatic installation of a Windows 
Printer when adding a Lasernet Meta Queue from Lasernet Meta running as a 
desktop application on Windows 10 and Windows 11. 

Fixed 

388040 CVE-
2023-
38169 

Server and 
Meta 
Installers 

Due to a vulnerability (CVE-2023-38169) in Microsoft OLE DB Driver for SQL 
Server, the installers for Lasernet Server and Lasernet Meta now install 
Microsoft OLE DB Driver for SQL Server 18.6.7 (instead of version 18.3.0). 

Improvement 
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Lasernet 10.5.2. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

368469 33020 Form 
Engine 

There was a compatibility issue after migration of forms running in page to job mode, 
which is designed for Lasernet 8 or earlier. 

Fixed 
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Lasernet 10.5.1. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

366901 - OCR Editor Lasernet 10.5 introduced an issue for “Wildcard matching in OCR Field” where an OCR 
Form could get corrupted in edit mode if an OCR Field was added to an item line in the 
body 

Fixed 

367782 - Database 
Command 

There was a memory leak when running database commands in the Lasernet Service Fixed 
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Lasernet 10.5. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

336356 - Azure 
Storage 
Input 

Added new JobInfos for downloaded blobs (Filename, FilenameWithoutExtension and 
Extension) 

Feature 
enhanced 

328736 - Client app Adding/changing a value for an Identifier field, assigned to an OCR Engine, will only 
update the selected job and no longer multiple jobs with same characteristics 

Feature 
enhanced 

326793 - Client app Added support for editing Regional Profile for OCR Fields added with date type in item 
lines 

Feature 
enhanced 

316878 - Client app Auto detect regional profile for a manually inserted date value Feature 
enhanced 

330169 - Client app Preview did not show document if filename extension did not match content Fixed 

333510 - Client app Added support for pressing Enter or F2 to open custom editor for Identifier or Date 
columns 

Feature 
enhanced 

342845 30926 Config 
Server 

Improved date format handling in various browsers Feature 
enhanced 

342705 - Developer Fixed an incompatibility issue when selecting edit module properties, after import of a 
migrated configuration, where the destination dialog properties unexpectedly was 
opened instead of the module properties 

Fixed 

341684 - Developer Renaming a configuration to the same name as an existing configuration was not 
possible 

Fixed 

341028 - Developer Checking for existing config name was case-sensitive, causing an issue where 
importing a configuration allowed the same name as an existing configuration, but with 
a different case 

Fixed 

340813 - Developer The Search tool crashed when clearing content in the “Text to search for” field Fixed 

317897, 
324753, 
326664 

25345 Developer A race-condition in object locking caused the error message "A lock for this object 
already exists.” 
 

Fixed 

335605 29989 Developer Lasernet Developer unexpectedly used deprecated master settings to create input 
printers after migrating a configuration from an earlier version 

Fixed 

325896 29307 Developer OCR Engine Module: Fixed an unhandled exception when changing default language 
for Dictionary 

Fixed 

324069 - Developer Added support to automatically resize columns for Server JobInfos to fit content Feature 
enhanced 

324614 26695 Developer Checkmark colors in tree view for the commit and revert dialogs were wrong for 
selected items 

Fixed 

335006 28309 Developer Improved error handling in property editor. Object names is set to read-only (not 
editable) to avoid an unforeseen warning that object already exist 

Feature 
enhanced 

329001 - Developer Improved Printer Profile error message handling for Printer Service module Feature 
enhanced 

298396 - Dropbox No longer supported Deprecated 

343858 31018 Formats Removed irrelevant debug logging for File Input + Output and Form Engine modules 
about none processed formats 

Fixed 

338174 30325 Form Editor 
/ Engine 

Fixed an issue for Rich Text output, where the DOCVARIABLE code, in some cases 
appeared in the output document for phrases if a criterion was not true 

Fixed 
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Internal 
Ref. 

External 
Ref. Area Details Status 

323797 28857 Form Editor 
/ Engine 

In rare cases, when a table was added to a region in the bottom of the page, it was 
longer than expected 

Fixed 

340375 30626 Form Editor Fixed a crash on the attempt to select another sheet in Sheet Options dialog Fixed 

335168 - Form Editor Fixed an issue changing type of content from "richtext\docx|pdf" to "xhtml" or vice 
versa 

Fixed 

326450 - Form Editor Clicking CTRL + left mouse button in 'Form Modifiers' dialog, to copy a modifier, did 
not work properly 

Fixed 

335168 - Form Editor Fixed an issue where UI was not updated immediately after changing the sheet output 
type between Rich Text format and XHTML 

Fixed 

338492 29595 Form Editor Improved warning handling, in the Font tab for Edit rearrange dialog, for non-supported 
font sizes, which could be present after migration of a configuration  

Feature 
enhanced 

343456 
 

- Form Editor By clicking on a rearrange or fixed text you will no longer enter inline editing mode by 
default. Selecting an object and pressing F2 is now required to enter inline editing 

Feature 
enhanced 

321775 - Form Editor Added a new context menu to “Keep text formatting” or “Keep text only” when merging 
two objects by clicking Ctrl + Alt before drag and drop 

Feature 
enhanced 

314404, 
337075, 
337076 

- Form Editor Added Auto Scroll support when selecting objects in Edit Rearrange dialog Feature 
enhanced 

331264 - Form Editor Auto focus for output pages has been improved when an input rearrange is selected Feature 
enhanced 

331265 - Form Editor Added support for PageUp, PageDown, Home and End keys for faster navigation 
across the output pages 

Feature 
enhanced 

322235 - Form Editor Status for Auto alignment and Auto scroll On/Off status added to the status bar Feature 
enhanced 

316685, 
320914, 
343456 

- Form Editor Made several improvements to the inline editor for Fixed Text and merged Rearranges Feature 
enhanced 

346912 - Form Editor Added support for a new attribute in XFDF template in Form Editor showing possible 
values extracted from PDF 

Feature 
enhanced 

353797 32109 Form 
Engine 

Fixed logging the "No form match found" message for TXT Forms Fixed 

357631 32288 Form Editor 
/ Engine   

There was a rounding error in number decimals when running a form calculation Fixed 

363672 32478 FTP Input 0 byte files could not be processed by SFTP protocol Fixed 

357721 32328 FTP Output SFTP protocol crashed when uploading two files after each other, to the same open 
connection 

Fixed 

298400 - Google 
Drive 

No longer supported Deprecated 

333837 - Mail Output Label names for Request Read Receipt and Request Delivery Receipt are aligned for 
Mail Output and Outlook Mail modules 

Feature 
enhanced 

282476 23921, 
31349 

Meta app A DataReader error message could sometimes appear in desktop app, avoiding a user 
to send a queue document to the server for a short period 

Fixed 

337576 - Meta 
Output 

Meta fields were not always set properly in Meta app, when receiving jobs 
simultaneously from multiple Meta Output modules 

Fixed 

336599 - Monitor app Filtering used minutes for months allowing 00-59 to be entered rather than 01-12 Fixed 

335626 - Monitor app The scrollbar was reset unexpectedly on License Page Fixed 

345076 30984 OCR Editor Aliases were used for language detection instead of term name and using the latest 
revision instead of the first 

Fixed 
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342295 - OCR Editor Fix for reselection of objects when using property grid causing loss of items in 
dropdowns 

Fixed 

324372 - OCR Editor Added support for reading the CSV file with Identifier values having blank column 
names 

Feature 
enhanced 

318225 - OCR Editor Added support for wildcard matching in OCR Fields Feature 
enhanced 

353765 - OCR Editor Improved the order of selectable date formats Feature 
enhanced 

342295 30790 OCR 
Engine 

Fixed an issue where XML output result from OCR Engine included alias name instead 
of field name as tag names for field names created with splitter functionality 

Fixed 

346051 - OCR 
Engine 

Body lines, with rearranges with height higher than a single line, would auto progress 
with the height of the tallest rearrange 

Fixed 

346056, 
347492 

- OCR 
Engine 

Extended logic is added to the greedy function when extracting OCR Fields in the body 
of a form. Greedy now stops before a line item with an “Exception” or “Must Contain” 
property is activated 

Feature 
enhanced 

341282 30710 Outlook 
Mail Input 

Added support for reading To property, from transport message header, containing the 
alias mail address 

Feature 
enhanced 

353046 31989 Outlook 
Mail Input 

Fixed an issue reading signed emails Fixed 

341528 30717 Outlook 
Mail Input 

Extended the module to accept an invalid email address for InputToName and an 
empty value for InputToEmail 

Feature 
enhanced 

337058 27018 Outlook 
Mail Input 

If images were inserted in an email, they were incorrectly counted as attachments in 
JobInfo InputAttachmentNumber 

Fixed 

346907 30405 Outlook 
Mail Output 

Added support for RetryAfter parameter when Microsoft Graph API throttles because of 
too many requests to server (error code 429) or if service is unavailable (error code 
503) 

Feature 
enhanced 

323331 - PDF Extract Removed the PDFPageOrientation JobInfo since it could not always be set with a 
proper value by module 

Fixed 

336206 - PDF Merger The checkbox of the inactive column was inverted Fixed 

291146 24919, 
24938 

PDF Merger Do not attempt to merge empty attachment. The attachment is skipped instead of 
failing job if attachment is empty (0 bytes) 

Feature 
enhanced 

334823 29816 PDF to Text Added support for PDF documents tagged with version 2.0 Feature 
enhanced 

326048 29331 PDF to Text Fixed that bounding boxes were not transformed when page was rotated, causing text 
placement to be incorrect in some cases 

Fixed 

334823 30054 PDF to Text Fixed a rendering issue related to the producer wPDF4 by WPCubed Fixed 

338704 - Printer 
Output, 
Printer 
Service App 

When printing attachments in PDF format, the Lasernet Server will support to 
automatically choose paper source in the printer by detecting the PDF page sizes in 
the PDF documents 

Feature 
enhanced 

326740 - Printer 
Service app 

When app is already started the printer list will automatically refresh when new printers 
are populated 

Feature 
enhanced 

329994 - Printer 
Service app 

Added support in UI for saving column order to registry and copying the order to other 

servers automatically 

Feature 
enhanced 

326751 26695 Script Editor Script was incorrectly saved when clicking the Parse button Fixed 
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344378 30942 Server / Job 
Engine 

Fixed a deadlock that could force a job to fail unexpectedly with the following error: 
 

Transaction (Process ID ##) was deadlocked on lock 
resources with another process and has been chosen as the 
deadlock victim. Rerun the transaction. 
[SQLAPIReader::retrieveRow] 

Fixed 

328879 29510 SharePoint Fix for browsing Document Library using Graph API without a valid authentication Fixed 

326751 29366 SharePoint Improved how the fields in the SharePoint Connection build the URL in UI to establish 
the connection to SharePoint 

Feature 
enhanced 

332009 29872 SharePoint Support for browsing and selecting accessible subsite IDs when authentication is set to 
application 

Feature 
enhanced 

363417 29510 SharePoint  Some listing sites were excluded when authenticating via app registration Fixed 

324309 29020 SQL Editor Added a workaround that Microsoft ADO returned parameter sorted by name instead 
of the order in which they appear 

Fixed 

324309 - SQL Editor Add + Remove parameter buttons appeared when selecting another stored procedure Fixed 

322684 - SQL Editor Only the last query result was shown in the Text tab when running multiple queries Fixed 

322985 - SQL Editor Added support for DataTable relations between queries in Database Command Feature 
enhanced 

322678 - SQL Editor Added support for viewing results as a DataSet Feature 
enhanced 

341317 - Tesseract 
OCR 

Added GhostScript as recommend default value for force producers/creators and 

abbyy;omnipage;tesseract as recommend default values for skip 

producers/creators to optimize processing speed and quality of output 

Feature 
enhanced 

316048 - Tesseract 
OCR 

Added a new PDF library to process and extract metadata from incoming PDF 
documents. 
 
Note: To ensure backward compatibility, after an upgrade from an older version, this 
setting is not activated by default. It is highly recommended for new users of the input 
management solution to activate this setting to be able to process a larger scale of 
PDF documents from various PDF providers 

Feature 
enhanced 

312565 - Web Server 
Input 

Added support for octet-stream in REST request (if single parameter) and response Feature 
enhanced 

328736 - Web Client 
app 

Identifier field, assigned to an OCR Engine, is updated for the selected row and not for 
other rows with documents from the same receiver 

Feature 
enhanced 

337070 - Web Client Preview did not show document if filename extension did not matched content Fixed 

318617 - Web Client Added a feature to show and edit a regional profile, assigned to a job by an OCR 
Engine, in column views for an OCR Field defined as a Date type 

Feature 
enhanced 

336610 - Web Server 
Input 

An invalid Expire header result was shown (the result is now 0 instead of -1) Fixed 

337708 30341 Web 
Service 

Improved WSDL parser handling Feature 
enhanced 

343466 30994 XML 
Transformer 
Editor 

The Find (CTRL+F) functionality was disabled Fixed 
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319679 - Azure 
Service Bus 

Create n/4 threads for the batch pool where n is number of cores to increase speed for 
multiple batches for servers with 8 cores (2 threads) and 16 cores (4 threads) 

Feature 
enhanced 

305966 - Azure 
Storage 

Fixed an UI issue where the Test Connection button was shown on top of Connection 
Tab, instead of in the lower bar 

Fixed 

309188 - Client app Added a feature to show and edit a regional profile, assigned to a job by an OCR 
Engine, in column views for an OCR Field defined as a Date type 

Feature 
enhanced 

306699, 
307349 

- Client app Lasernet OCR, System and Job Tracking profile bands have been re-organized in UI Feature 
enhanced 

328699 - Client app Identifier value is now only changed for the selected job row and not for other job rows 
matching same AutoCapture or OCR Forms 

Feature 
enhanced 

317353 - Config 
Server 

Instance names were case-sensitive Fixed 

313301 - Developer Added support for duplicate and copy/paste to Criteria dialog for a Destination added to 
a module 

Feature 
enhanced 

312547 - Developer Added a files column in the Resources file folder view to show number of files within a 
folder 

Feature 
enhanced 

312075 - Developer Added support for export / import of fonts stored in the Resources\Fonts folder Feature 
enhanced 

322867 - Developer The form names were sometimes grayed out when multi server instances are present 
in a configuration 

Fixed 

296964 - Form Editor 
/ Form 
Engine 

Added combining support to CSV as output format, to support a more complex CSV 
structure based on individual sheets in the same form 

Feature 
enhanced 

325773 - DM Upload Expanded authentication options by adding support for API Keys and OAuth2 (for SSO 
environments) 

Feature 
enhanced 

303632 - Form Editor 
/ Form 
Engine 

Added a new setting "Allow further form matching if no sheets are matched" to the 
Form Criteria dialog for forms with XML as input format 

Feature 
enhanced 

223499  
 

- Form Editor Added support for a "Keep source formatting" or "Keep text only" dialog when doing a 
copy/paste or a merge of two rearranges having different styles 

Feature 
enhanced 

306339 - Form Editor Objects are merged when selecting the Ctrl-key + arrows or drag-and-drop to another 
object 

Feature 
enhanced 

306337 - Form Editor Added an Auto alignment checkbox in the View submenu to turn on/off the auto 
alignment functionality for EMF/PDF formats. A feature to avoid that position is not 
always set to an integer when moving an object to a new Y position with arrow keys 
up/down 

Feature 
enhanced 

295432 - Form Editor Added support for colored QR barcodes. This enables support for white QR barcodes 
printed on Zebra label printer mounted with black labels 

Feature 
enhanced 

316083 - Form Editor Several improvements added to the in-line editing control Feature 
enhanced 

302074 - Form Editor Added placeholder text to required fields for Swiss QR barcodes Feature 
enhanced 

298558 - Form Editor Optimized moving an object by arrow key when aligning to other objects in EMF/PDF 
forms 

Feature 
enhanced 
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296716 - Form Editor Added a Base64 property in Sheet Options to encode output JobData Feature 
enhanced 

310703 - Form Editor Removed non-supported actions, Move or Copy sheets, from the Cells menu in the 
Spreadsheet editor 

Fixed 

322502 - Form Editor A crash occurred when attempting to open another configuration after RichText\DOCX 
form was previewed 

Fixed 

322460 - Form Editor The cursor used to show table columns did not change to the Move Right/Left cursor 
mode for EMF output 

Fixed 

313439 - JSON Web 
Token 

Added support for JSON Web Token viewer in module view Feature 
enhanced 

314408 - JavaScript Added new function jobinfoIndexOf to search through a JobInfo array on a Job looking 
for a particular value 

Feature 
enhanced 

321739 28721 Mail Output A crash occurred when "Do not insert job data in an attachment" was enabled Fixed 

303542 - Monitor app Disabling non-supported tabs when a log file is opened from disk Feature 
enhanced 

317911 - OCR Editor Fix for scrollbar being unable to scroll to show all columns or rows for documents in 
landscape 

Fixed 

315970 - OCR Editor Added support for editing of Exceptions via property editor Feature 
enhanced 

311618 - OCR Editor Identifier view in OCR Editor app is sorted alphabetically like the Client app Feature 
enhanced 

316258 - OCR Editor 
/ Engine 

Faster scrolling support and processing of OCR Forms for large documents Feature 
enhanced 

316015 - OCR Editor 
/ Engine 

Optimized speed when running the Understand tool and AutoCapture feature Feature 
enhanced 

316874 - OCR Editor 
/ Engine 

Optimized the algorithm for recognition of date formats in documents to auto set a 
regional profile for an OCR Field defined as a Date type 

Feature 
enhanced 

305017 - OCR Editor 
/ Engine 

Added long dates to the list of built-in date formats Feature 
enhanced 

323551 - OneDrive Incoming files were not processed properly due to UTF-8 characters not working Fixed 

315231 - PDF to Text Default value for Extract metadata settings in PDF to Text module is now set to “Not 
active”, which is the recommended setting in a production environment for highest 
speed 

Feature 
enhanced 

315872 - Printer 
Failure 
Profile 

Added a new JobInfo named PrinterFailureMessage, which contains the error message 
when a print job fails due to a Printer Failure Profile rule 

Feature 
enhanced 

303479 26657 Printer 
Output / 
Printer 
Service 

Fixed an issue with Windows printer names containing special characters, like 
hashmarks and slashes 

Fixed 

317451 28248 Script Editor Added support for searching outside functions and within function name Feature 
enhanced 

313708 - Tesseract 
OCR 

Optimized the 'Auto Rotate' detection feature to obtain readable rotation in documents Feature 
enhanced 

316902 - Web Server 
/ Service 

Added unique name handling for methods Feature 
enhanced 

316989 - Web Server 
/ Service 

Disabled the OK button when editing method if name is not unique within the web 
service 

Feature 
enhanced 

313300 
 

- Web Server 
/ Service 

Deleting a destination would afterwards select item above and not the next item in the 
list 

Feature 
enhanced 



 

25 Lasernet 10 Changelog 

Internal 
Ref. 

External 
Ref. Area Details Status 

313303 
 

- Web Server 
/ Service 

Added support for duplicate and copy/paste to the method list for web services Feature 
enhanced 

320381 27621 XML 
Transformer 

There was an issue with transformations replacing elements with text nodes Fixed 
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317908 25345 Developer Optimized updating and population of Forms list to improve performance when working 
with many forms 

Fixed 

316358 - Dictionary 
Service 

Enclose path to service executable in quotes to increase the security level Fixed 

318887 - DM Upload Enabled the use of strong crypto and recent TLS versions  Feature 
enhanced 

315145 27740 Form Editor Scripts in sub form mode did not run when pressing Shift+F5 Fixed 

271720 - Form Editor A regional profile, set to inactive, would disappear from Input/Output format tabs Fixed 

319088 - Form Editor Fixed an issue in various dialogs where manual adjustment of column width in UI did not 
work after upgrading to 10.3 

Fixed 

320314 28598 Form Editor The page selection of overlay files in 'Sheet options' dialog was wrong Fixed 

315440 - Form Editor 
/ Engine 

Swiss QR Barcode encoded incorrect value issues for amounts with a certain number of 
decimals 

Fixed 

315254 - JobInfo 
Scanner 

Fixed a UI issue when Extraction Mode was set to Leave Fixed 

316358 - Lasernet 
Service 

Enclose path to service executable in quotes to increase the security level Fixed 

315463 - Login In rare cases, the Login app was not allowed to create a local directory to install 
applications after they were downloaded from the Lasernet Server 

Fixed 

315973 - OCR Editor Optimized speed when loading large documents Feature 
enhanced 

316134 28082 OneDrive 
Input 

A crash occurred due to Microsoft now sending empty response when remote file is 
deleted successfully 

Fixed 

315444 - Printer 
Profiles 

Lasernet Developer could crash when adding a new profile by right-clicking in left tree Fixed 

316358 - Printer 
Service 

Enclose path to service executable in quotes to increase the security level Fixed 

319536 - Printer 
Service app 

Log could not always be retrieved from Printer Service Fixed 

315993 28051, 
28044 

Scheduler 
Input 

Fixed a service crash after a deployment caused by a race condition Fixed 

315849 28032 SharePoint 
365 

Fix for testing app registration connection from the UI in Lasernet Developer Fixed 

317955 28290 Text Filter Fixed an issue with $0 (full match) when using 'Match once' and/or 'Set JobInfo...' 
options 

Fixed 

312269 26293 Web 
Service 
Input 

Lasernet Service crashed when a job was forwarded to Preview port from Web Service 
module 

Fixed 
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293924 25345 Developer / 
Config 
Server 

Refactored migration to fix missing configuration file version and other migration bugs 
between Lasernet 9 and 10. 
Important: If you upgrade from any previous version of the 10-series you cannot 
downgrade and afterwards open a configuration stored in the Lasernet Config Server. 
The list of configurations will remain empty. 
 
We strongly recommend that you create a backup of the Lasernet Config Server as 
described in the following article, before you upgrade to this version: 
 
https://support.formpipe.com/kb/articles/110 

Fixed 

310574 - Developer A handle leak could cause a crash when exporting objects Fixed 

309122 - Developer There was an issue with the UI in the General tab of the JobInfo Profile dialog, where 
settings for Type and Show were not separated  

Fixed 

309552 - Developer There was an issue with the UI for Modules > Modifiers > Criteria tab, where the Add 
JobInfo Criteria incorrectly figured as a Scheduler Criteria 

Fixed 

312506 - Form 
Editor/Engine 

Added support for embedded fonts in SVG images Feature 
enhanced 

312239 - Form Editor Changing sheet in 'Sheet Options' dialog did not refresh value for 'Maximum image 
DPI' setting in Advanced tab 

Fixed 

311787 - JavaScript F.isFile and F.isDir returned incorrect Boolean in JavaScript Fixed 

307970 - OCR Engine Empty values for DisplayMember and ValueMember in OCR Engine > Identifier tab 
were not backward compatible 

Fixed 

312009 - Printer 
Service 

Added “Reset Layout” functionality in Printer Service app > View menu, to reset layout 
of tool bars in UI 

Feature 
enhanced 

311787 - Printers and 
Drivers 

Added missing printer drivers to Lasernet Developer installer. Fixed an issue where 
Lasernet Printer Capture 10, was not installed and running if Lasernet Developer 10.2 
or 10.3 were running on a local computer 

Fixed 

313695 - SharePoint Original RefreshToken was mistakenly copied from configuration overwriting any new 
RefreshTokens obtained on authentication, causing login issues after typical 90 days 

Fixed 

312587 - Web Server 
Input 

Added missing ScopedThreadModuleID information to Lasernet Server log Fixed 

 

https://support.formpipe.com/kb/articles/110
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264507  Azure 
Storage 

Added support for using SAS keys on container level Feature 
enhanced 

290863  Client app Optimized speed when fetching job by only loading Identifiers list when selecting the 
Identifiers column 

Feature 
enhanced 

296540  Client app Added a splash screen at start up Feature 
enhanced 

303583  Client app Changed date, number and amount fields in grid to be strings (already supported by 
web client). 

Feature 
enhanced 

292636  Client web Added support for viewing user and system JobInfos (already supported in client app) Feature 
enhanced 

292876  Client web Added support for editing of identifier values (already supported in client app) Feature 
enhanced 

303522, 
304038, 
305093 

24435, 
25201, 
26262 

Client web Fixed that JobInfo with an empty value, set from a JobInfo Profile, were not editable Fixed 

297934  CSV Added support for CSV input with files including a BOM character Feature 
enhanced 

275711  Form Editor The used fonts are automatically extracted from forms and saved into the configuration 
in resources/fonts 

Feature 
enhanced 

276685  Form Editor Added a new behavior to set an "Additional progress after last" Region Feature 
enhanced 

280629  Form Editor Support for hyperlink added to images in PDF documents with EMF as source Feature 
enhanced 

287561  Form Editor Added password support to XLSX output format Feature 
enhanced 

287562  Form Editor Added password support to DOCX output format Feature 
enhanced 

224154  Form Editor Improved navigation with arrow keys in in-line edit mode for objects having a mix for 
rearranges and fixed text 

Feature 
enhanced 

296866  Form Editor Changed the behavior for "Select last Grab file from server F12" functionality to use 
server selection in toolbar instead of a pop-up to define which server to get the files 
from. 

Feature 
enhanced 

293640  Form Editor Remove bitmap and printer specific reference fonts from the font selection list Feature 
enhanced 

276685  Form Editor Added a new behavior to set an "Additional progress after last" Region Feature 
enhanced 

303186  Form Editor Fixed a crash when selecting any type of 1D barcode and the current barcode was of 
type 2D 

Fixed 

307362 26380 Form Editor Fixed a crash led by processing of XHTML rearranges Fixed 

293829  HTTP 
Output 

Added a new property to set an empty body for HTTP POST/PUT requests Feature 
enhanced 

293490  Developer Improved handling of initial column sizes by automatically resizing to content Feature 
enhanced 
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294329  Developer Improved speed in UI when working with configurations having many objects Feature 
enhanced 

294068  Developer Optimized loading of preview widget for phrases Feature 
enhanced 

295702  Developer Validator is improved to show none valid destinations in a sheet added to form Feature 
enhanced 

288471  Developer Moved the “Import grabs” feature from Server settings to Resources Feature 
enhanced 

286736  Developer Added the type of sheet output to the Forms Details view Feature 
enhanced 

296874  Developer The dialog to select a server instance in a configuration with multiple instances, will 
now pop-up every time, when a connection is tested in a module 

Feature 
enhanced 

294396  Developer Fixed order of imported objects, to guarantee that Form Engine objects are imported 
before form objects 

Fixed 

294395  Developer Fixed some issues when importing large configurations (>500 mb) Fixed 

305445  Meta app Warning message in preview windows was missing when print job was too large to be 
processed by Meta app 

Fixed 

305096  Meta app Fixed an issue where large input files were polled multiple times from disk Fixed 

297047  Monitor Added a new featured to Open logfile in (app only) to view a copy of a downloaded log 
from server 

Feature 
enhanced 

296542  OCR Editor Added a suggestion for filename when saving an OCR Form to disk Feature 
enhanced 

296540  OCR Editor Added a splash screen at start up Feature 
enhanced 

298055  OCR 
Engine + 
Client app / 
web 

Added support to show either DisplayMember and ValueMember for Identifiers Feature 
enhanced 

298958  PDF 
Security 

Changed the title for PDF Producer to Formpipe Lasernet x.x (PDF Security API 
x.x.x.x) 

Feature 
enhanced 

296898  PDF to Text Added a new feature to detect landscape in PDF documents and set new values for 
rows and columns. Default values can cause none backward compatibility in 
documents running in landscape mode. 
Set landscape values to same values as portrait for backward compatibility when 
upgrading from older versions 

Feature 
enhanced 

296914  PDF to Text Added new feature settings to remove adjacent dots in documents. Default value 
(active) can cause none backward compatibility in documents with adjacent dots. 
Deactivate this setting for backward compatibility when upgrading from older versions 

Feature 
enhanced 

297024  PDF to Text "Remove underscores" is now activated as default value when adding new modules to 
configuration 

Feature 
enhanced 

305574  Printer 
Output 

Potential fix for printing issue to network printers with restricted user rights – “Error 
given by system: Access is denied” 

Fixed 

267927  Printers and 
profiles 

Changed default scale mode to Actual Size, when printing PDF documents via Printer 
modules, and added a new JobInfo 'PrintPDFFitToPage' to set “allow fit / shrinked”, 
which was the old default behavior 

Feature 
enhanced 

299020  Server New default value for ModifierFailed JobInfo is set to Log instead of NoLog Feature 
enhanced 

298971  Server Fixed a crash in service caused by database cleaner, when backup for MS SQL Server 
LocalDB (Embedded) was set to “On Service Startup” 

Fixed 

302085  Server Fixed a race-condition when multiple web clients request module icons Fixed 
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303169 27008 SharePoint Added support for getting throttled or blocked by SharePoint Online, when sending 
delete requests, because of extensive traffic to endpoint via Graph API 

Fixed 

297607  Web Server Added support for JobInfo Substitution for server certificate settings on Web Server 
Input port 

Feature 
enhanced 
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303172 - Developer The Test Connection button in the module UI did not work properly for SharePoint 
modules 

Fixed 

302307 - Printer 
Service 

Addressing a Printer Profile from script and a Printer Name via JobInfo substitution for 
Printer Service module / service did not work properly 

Fixed 

294117 25435 SharePoint Uploaded documents were randomly missing attached meta fields for Graph API, 
because of extensive traffic to endpoint via Graph API 

Fixed 

303169 - SharePoint Added support for getting throttled or blocked by SharePoint Online, because of 
extensive traffic to endpoint via Graph API 

Fixed 

303184 - SharePoint Read of SettingsRetainer (Tokens) could fail due to another thread read/writing the file, 
because of extensive traffic to endpoint via Graph API 

Fixed 

 



 

32 Lasernet 10 Changelog 

Lasernet 10.2.3. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

299438  Azure 
Storage 

Service crashed when connection was mistakenly not set in module Fixed 

298114 26184 Client app Preview was cleared when same job was present as first job in multiple levels Fixed 

298573  Developer The object's name was not presented in the Script Functions category in the Validator 
dialog 

Fixed 

299420 26353 Outlook 365 
+ 
Exchange 

There was an issue reading signed MIME mails where name was not set Fixed 

294095 25443, 
25992 

Scheduler Having multiple input modules using scheduler to start jobs could, in rare scenarios, 
process twice instead of once 

Fixed 

288936 24873, 
22246 

SharePoint There was an issue with retainer files and the renewal of tokens with multiple 
SharePoint 365 Graph API modules in the configuration 

Fixed 

302009 26154 SharePoint Optimized speed for upload of documents to SharePoint by allowing multiple concurrent 
connections 

Feature 
enhanced 
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295875 25767 Client (app) Improved validation coloring shift between statuses and tooltip when changing 
values in columns 

Fixed 

295360 25641 Config 
Server 

Added 'Reset Password' functionality for local users Fixed 

295905 25345 Config 
Server 

Fixed an “Operation time out” when migrating and importing large configuration with 
1 GB of overlays 

Fixed 

294645 - Developer Content in preview window, listed in resource view, was not updated visually before 
the file was re-selected, if the object was reverted or edited externally 

Fixed 

297241 - Developer Handle exceptions when opening configuration referencing unknown third-party 
.NET modules 

Fixed 

295901 24825 Form Editor Fixed an issue where preview mode would crash application Fixed 

296699 - Form Editor There was a duplicated list of fonts in the fonts tab of the rearrange settings dialog Fixed 

297051 - Form Editor The 'Save As' action for the Preview dialog did not include an extension for output 
filename properly 

Fixed 

293964 25393 Form Editor Fixed an issue addressing the printer profile for Printer Service module from the 
addPrinterProfile object in JavaScript 

Fixed 

296701 25875 Monitor Save dialog did not append selected extension when saving log Fixed 

295603 25688 OCR Editor Fix for error in forms list when showing 'Move to Index' dialog and rows are filtered Fixed 

296507 - OCR Engine Added support for a list of reserved names, in add or edit mode, for OCR Field 
names in OCR Engine 

Feature 
Enhanced 

295082 - SDK + 
JavaScript 

Added functions to get list of images and path to all resources from SDK and 
JavaScript 

Feature 
Enhanced 

295696, 
295904 

- SharePoint 
365 
Connection 

Added support for login domain for OnPrem REST and 'None' prefix for URL 
without /sites or /teams 

Feature 
Enhanced 

295906 25773 Text Filter Fixed broken handling of $0 (full match) in replace expressions Fixed 

 



 

34 Lasernet 10 Changelog 

Lasernet 10.2.1. 

Maintenance Report

Internal 
Ref. 

External 
Ref. Area Details Status 

288856 - Barcodes Symbology barcode fonts, deprecated in 10.0, are now supported, on user request, 
from this version 

Enhanced 

288660 24435 Client app Error message was shown when editing JobInfos, which were actually never set, but 
saved via JobInfo Profile 

Fixed 

294550 - Config 
Server 

Unable to add groups to Security Roles if there are a large number of groups (10.000) 
in Lasernet or Active Directory 

Fixed 

292233 - Developer Job Mode was unable to execute method to show job flow for processed job Fixed 

291359 25017, 
25120 

Developer Search mode crashed when there were forms or subforms in the configuration Fixed 

292254 - Developer Autoform DM Upload module JobInfos were missing in JobInfo dropdown lists Fixed 

292495 - Developer History changes did not show scripts properly Enhanced 

275787 - Form Editor Opening PDF in Preview mode, with a form that contains specific type of SVG images 
rotated to 180 or 270 degrees, caused a crash 

Fixed 

292954 - JavaScript 
Editor 

Fix for issues when searching for contents that occurred in multiple functions Fixed 

293923 - OCR Editor Removed flag requirement for header+footer fields to avoid OCR Forms created in 
older versions being non-compatible 

Fixed 

293165 8562 PDF Engine Enclosed XMP Metadata in x:xmpmeta tag when generating PDF/A for German 
ZugFerd format. Avoids validation failure in certain validators, even though the tag is 
only optional 

Fixed 

292943 - Printer Port Lasernet processing failing: HTTP response content-type was not application/json Fixed 

293680 - Rich Text 
Converter 

DOCVARIABLES were not replaced with Phrases Fixed 

292160 25156 Service A race-condition caused a crash when loading forms and then printing to Printer Input Fixed 

291190 24980 SQL 
Database 
Connection 

ntext was read as blob and not string Fixed 

293190 - Tesseract 
OCR 

PDFs that did not restore a clean graphics state caused missing OCR processed 
image 

Fixed 
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282312 - Azure AD Azure AD tokens expired after a short period of time Fixed 

287215 - Code Page 
Conversion 

Added support for IBM852 (MS-DOS Latin 2), to write Central European languages 
(such as Bosnian, Croatian, Czech, Hungarian, Polish, Romanian, Serbian, Slovak or 
Slovene) 

Feature 
enhanced 

282658 - Config 
Server 

Fixed possible race-condition when refreshing user claims. Cached user claims and 
external user roles are no longer refreshed on every request but are updated every 5 
minutes 

Fixed 

214351 - Config 
Server 

Preventing to add server instance with a port number or instance name already being 
used by server 

Fixed 

231628 - Form Editor Added support for embedded files when outputting PDF/A from Rich Text format Feature 
enhanced 

234360 - Form Editor Logger Logged RecognizedForm information twice in succession Fixed 

280872 23706 Form 
Engine 

Fixed a memory issue with intensive use of barcodes or images in large print jobs Fixed 

284873 - Form 
Engine 

Fixed an error "Not a SharePoint Graph connection!" when retrieving blobs in forms via 
SharePoint REST API (Legacy) connection defined in Form Options → Connections 

Fixed 

266739 - Developer Added schedule criteria to XML Transformer, PDF Form Filler and Overlay forms similar 
to Form Engine forms introduced in 10.1 

Feature 
enhanced 

282624 23890 Developer Improved the size of the scrollbar in the commit/show changes dialog for changes 
containing long XPaths 

Fixed 

268815 - Developer Changed Export action to show Export Object(s) dialog Feature 
enhanced 

269133 - Developer Added created + modified columns to View Dependencies dialog Feature 
enhanced 

283435 - License 
Manager 

Closing the migration dialog could return an unhandled exception during a database 
migration for Config SQL Server 

Fixed 

275124 22233 OCR Editor When splitting two strings, only the first char was discarded, not the full splitstring Fixed 

281029 - OCR Editor Added a new "Update and Close" button to toolbar Feature 
enhanced 

282115 - OCR Editor Changed default Split String setting from space to nothing Feature 
enhanced 

284256 - OCR Editor Added support for moving and removing Zone for Search and Criterion fields Feature 
enhanced 

283805 - OCR Editor Grab data was not kept when saving AutoCapture Form as an OCR Form Fixed 

284281 - OCR Editor Added support so that the “Must Contain” property for Data Fields is used as an extra 
parameter to capture an OCR Field 

Feature 
enhanced 

n.a. - OCR Editor Data Field values can be set to option "Required" for Data Fields added to header/footer 
instead of body only 

Feature 
enhanced 

283750 - OCR 
Engine 

Validation of Identifiers added to OCR Engine did not work after releasing a job for Auto 
Captured documents 

Fixed 

282749 - OCR 
Engine 

Added new 'OCRAutoCapture' JobInfo when job is auto captured by engine Feature 
enhanced 
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284052 - OCR 
Engine 

Fixed reading preview JobData from wrong JobInfo causing AutoCapture Form to have 
no PDF 

Fixed 

252215 
+ 
284085 

21594 OCR 
Dictionary 

Backward property added to OCR Field in Dictionary to search backwards for OCR 
Fields in AutoCapture and Understand mode 

Feature 
enhanced 

281537 - Outlook 
Mail 

Added support for “Create draft without sending it”, in the Outlook Mail output module, 
and a JobInfo “MailDraft” to overwrite the setting 

Feature 
enhanced 

284888  SDK SDK Module was not listed in Monitor's License tab Fixed 

269726 - SharePoint Removed FieldsOnly option from SharePoint Output module (only required for update 
command in SharePoint Modifier) 

Fixed 

268487 - SharePoint Added password substitution support to SharePoint module running in legacy mode Feature 
enhanced 

267934 - SharePoint Added authentication as application for SharePoint Graph communication Feature 
enhanced 

282912 
+ 
283274 

- SharePoint Added support for on-premise server for Legacy REST API Feature 
enhanced 

282737 23960 Regional 
Profiles 

Fixed a service crash on processing a Regional Profile with none valid settings + added 
a validation check in UI to prevent none valid settings 

Fixed 

282106 23890 XML 
Transformer 
Editor 

Added support for showing the name of a loaded grab file with path in status line Feature 
enhanced 

282626 23890 XML 
Transformer 
Editor 

Edit Action dialog in XML Transformer Editor did not scale properly Fixed 
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281276 Deskpro 
23761 

HTTP HTTP input module crashed when a job was read that could be null after 
introduction of JobInfo 'HTTPCookies' in Maintain Session feature 

Fixed 

281524 Deskpro 
23720 

JSON to XML JSON to XML modifier arrays were not working properly in all cases Fixed 

281563 Deskpro 
23732, 
23934 

Lasernet Config Migrating LocalDB config to SQL database failed with an SA Exception Fixed 

282624 Deskpro 
23890 

Lasernet Developer The scrollbar was missing in some situations because the column was 
not resized to match content 

Fixed 

281295 - Lasernet Form Editor JobInfo "DataFormat" was logged twice when a form was set to XML 
Input and TIFF output 

Fixed 

280615 - Lasernet Form Editor Pad option for Rearranges could, in rare scenarios, add the wrong 
characters to the end of the output string 

Fixed 

274948 - Outlook Mail Outlook Mail incorrectly reported -1 unread mails. We implemented 
special handling for the incorrect value from Microsoft Graph API when 
reading number of unread mails from inbox 

Fixed 

283206 Deskpro 
22988, 
23855 

PDF Engine Barcode label was clipped in PDF Engine/Modifier in custom Paper 
Format 

Fixed 

278051 Deskpro 
23452 

Printers and profiles Added support for setting PrintDocName and PrintAttachmentDocName 
in print queue for attachments 

Feature 
enhanced 

274949 - Scheduler Input Criteria column was incorrectly shown on Scheduler Input module Fixed 

277538 Deskpro 
22939 

SharePoint SharePoint 365 graph connection crashed when displayName was 
missing (using name instead in such case) 

Fixed 

280199 Deskpro 
23010 

Lasernet Client There was an error editing fields extracted via OCR Engine that were not 
JobInfos 

Fixed 
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281207 - Autoform DM 
Upload Module 

Module has been updated with fix for a security vulnerability identified in 
Log4Net.dll 

Security 
enhanced 

274125 - Developer The grabs are now hidden from the Dependency Walker Fixed 

271971 - Developer There were some minor Dependency Walker stability issues when file was 
removed or renamed 

Fixed 

271916 - Developer Added support for collapse/expand in View Dependencies Feature 
enhanced 

230429 - Developer All changes disappeared from a configuration when they were not committed 
and the configuration was renamed 

Fixed 

271966 - Developer/Module 
Tester 

Module Tester crashed in Engine/Output modules like Tesseract because of 
missing PublicID 

Fixed 

275003 - Form Editor Rearranges containing a large number, with 24 or more digits, could cause a 
crash when rearrange was set as a number type 

Fixed 

269464 Deskpro 
22300 

Form Editor WMF & SVG images sometimes rotated the wrong way Fixed 

276512 - Form Editor The 'Select Grab File(s)' dialog window closed incorrectly when canceling the 
information dialog 

Fixed 

274434 - Form Editor Icon for module type was missing in the destination list view Fixed 

274238 - Form Editor Incorrect data was added to the "UD– AdressTyp" for Swiss QR Codes Fixed 

269178 - Form Editor In rare scenarios, Object was still locked even though the first multi-user had 
closed the object 

Fixed 

270572 - Form Editor Removed Lasernet Reference Printer column in Form ► Define Sheets menu Deprecated 

254151 Deskpro 
21600 

Lasernet Client Jobs were not editable at highest queue level Fixed 

270581 - Lasernet Client The View ► Select color swatch selection was not saved between sessions Fixed 

280871 - Lasernet Client There was a security issue where a user could remove jobs and change 
JobInfos in Lasernet Client without the required permissions 

Fixed 

281479 - Lasernet Server There was an issue in the job engine where read rights were incorrectly used 
instead of write rights when releasing a queue in Lasernet Client 

Fixed 

196753  PDF Engine Reduced memory usage when creating PDF files Feature 
enhanced 

271703 - PDF Extract Handling extraction of meta fields that corrupted log if JobInfo value extracted 
from PDF included a null character 

Fixed 

271588 - PDF to Text Module failed to decode some text Fixed 

276454 - PDF to Text Double spaces could occur between text strings in jobs after running Tesseract 
OCR (Forced mode) and PDF to Text modifier 

Fixed 

272719 - Tesseract Improved support for embedded user-words and user-patterns files Feature 
enhanced 

280631 - Web apps Lasernet URLs were not case insensitive Fixed 

278082 - Web Server Security patch for configuration, authentication, patching, segmentation and 
encryption levels 

Security 
enhanced 
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270603 - Outlook 
Mail 

The multi-request Graph API, introduced in Lasernet 10 to support attachments up to 
150 mb, has been temporarily removed because larger attachments did not send. 
 
The single-request Graph API has been re-instated while we work on resolving quirks 
with the multi-request method (ID’s and sent items). This will support the sending of 
files up to 4 mb by removing larger attachments. Now, only attachments in the Outlook 
Mail output module, also supported by Microsoft in their single request Graph API, will 
send. 
 
Note: We are working to restore the multi-request Graph API. 

Temporarily 
fixed 

270699 - Outlook 
Mail 

The error message “Unable to create files” was incorrectly shown when renewing 
tokens (retainers) in multi-thread mode. 

Fixed 
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268856 Freshdesk 
22419 

Outlook 
Mail 

Error displayed saying that email could not be sent. "Access is denied..." or "Cannot 
delete mails in sent items” 

Fixed 

269049 - Outlook 
Mail 

Activating combining mode in Outlook mail module only attached document from last 
job 

Fixed 

269071 - Outlook 
Mail 

Introducing a validation; jobs/attachments greater than 150MB will now fail the job Feature 
enhanced 

268221 - SharePoint Output module was not able to upload documents only SharePoint commands Fixed 

267641 Freshdesk 
22246 

SharePoint 
Output 

Did not generate retainer file with access token with running SharePoint 365 with 
Graph REST API 

Fixed 

269258 - Developer Icon was missing for PDF Form Filler modifiers in diagram mode Fixed 

269438 - Developer Icon was missing for 3rd party .NET modifiers in diagram mode Fixed 

269355 - Developer Printer Profile issue when opening configuration after having removed default profile 
from Lasernet Printer Service 

Fixed 

269439 - Core Added AppList as source of Access-Control-Allow-Origin to mitigate Cross Origin 
Resource Sharing misconfiguration to Lasernet RestServer 

Security 
enhanced 

269440 - Core Added HTTP Strict Transport Security policy header to Lasernet RestServer Security 
enhanced 

269441 - Core Disabled caching for all responses except on file-based resources used by websites on 
Lasernet RestServer 

Security 
enhanced 

269637 - XML 
Transformer 
Editor 

Checkbox for setting Action tools pane to active is now editable Feature 
enhanced 

268207 - Developer Minor fixes and support for additional object types added to the Dependency Walker Feature 
enhanced 

268122 - Developer Added toolbar to Dependency Walker functions in Export Dialog Feature 
enhanced 

268549 - Web Client Server settings are now loaded during start up to avoid a manually clear of local 
application storage if parameters in server settings have been changed 

Feature 
enhanced 

236695 - Web Client Manage Access Rights for Client Role on Config Server was not read properly and 
could cause that a user could list and select a none-allowed server instance 

Fixed 

267936 - Web Client The Select All jobs checkbox has been temporarily removed from UI to avoid heavy 
load on a server instance storing a large amount of jobs in the selected category (will 
be introduced again later with a new paging feature) 

Fixed 
temporarily 
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234994 - Form 
Editor 

Developer crashed when opening forms with non-existing Master reference Fixed 

229732 - Form 
Editor 

Scrolling text up/down did not always work, in the phrase's preview dialog, for DOCX 
output format 

Fixed 

230065 - Form 
Editor 

In-Place editor mode must de-activate selection of grab files Fixed 

230420 - Form 
Editor 

In-Place editor mode must ignore text editing of merged rearranges. Minor improvements 
and more error handling added to In-Place editor 

Fixed 

232318 - Form 
Editor 

The form crashed on closing the XSLX output sheet without saving Fixed 

236710 - Developer Export Object(s) and Add Form(s) dialogs list contained duplicates for forms and engines Fixed 

235163 - Core Validation checks added to the process of renaming a user, group or security role Fixed 

229501 - Core LocalDB backup file was not created when backup time was set to option “Scheduled” in 
server settings 

Fixed 

230321 - Core Crash with SQL Express DB loggin (SAException(NativeCode=1205, Text=Transaction 
(Process ID 55) was deadlocked on lock resources with another process and has been 
chosen as the deadlock victim 

Fixed 

230407 - Core Potential race condition in RestServer when removing a controller while a request is in 
progress 

Fixed 

234805 - Client Various fixes to the 'Show Auto Filter Row' functionality Fixed 

235506 - Monitor Licensed modules and general information was missing from the Licensing tab Fixed 

234659 - OCR Editor OCR Editor could not open documents via Client App for port numbers other than 33443 
(default) 

Fixed 

250556 21599 OCR Editor Port Field in OCR Editor was seen as a number and you cannot change it properly Fixed 

226226 - Job Engine Incorrect index was used when selecting from JobInfo table in some cases Fixed 

235032 - HTTP Running HTTP modifier with a Client Certificate could, in rare scenarios, cause a crash Fixed 

234907 - OCR 
Engine 

REST API returns an unexpected number of rows, in rare scenarios, when OCR 
Dictionary is activated but could not connect to DB 

Fixed 

236282 - Web Client Filenames sometimes missing in the Web Client when jobs were paused via OCR 
Engine 

Fixed 

268549 - Web Client Server settings are now loaded during start up to avoid a manually clear of local 
application storage if parameters in server settings have been changed 

Feature 
enhanced 

236695 - Web Client Manage Access Rights for Client Role on Config Server was not read properly and could 
cause that a user could list and select a none-allowed server instance 

Fixed 

267936 - Web Client The Select All jobs checkbox has been temporarily removed from UI to avoid heavy load 
on a server instance storing a large amount of jobs in the selected category (will be 
introduced again later with a new paging feature) 

Fixed 
temporarily 

229191 21048 Developer An import could, in rare scenarios, overwrite existing object w/o notification Fixed 

224160 20662 Forms PDFs formatted in A3 Landscape where PNG images were cut off at A4 margins Fixed 

234999 16049 Forms PDF format documents with URL links included in a merged block of text Fixed 

231217 - Forms Linefeed before a merged block of Asian characters could cause characters to disappear Fixed 
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237126 21641 HTTP Changed error message to warning, on certificates not being marked for client auth; a 
certificate does not require a list of intended usages 

Fixed 

235379 21540 OCR Multiple Supplier Lists files, added to multiple OCR Engines, incorrectly loaded the 
contents added to the first loaded OCR Engine 

Fixed 

222624 - Outlook 
Mail 

Images set to attached in HTML forms was not visible in all mail clients Fixed 

252060 21706 SharePoint Error parsing result when SharePoint INSERT Command fails, causing Output Port to 
not fail Job 

Fixed 

234861 - OCR Embedded Dictionary database was not compatible with Microsoft SQL LocalDB 2017 Fixed 

235213 - PDF 
Merger 

Merge error when PDF contains a catalog with indirect reference to a Names dictionary Fixed 

230734 - Config 
Server 

Crashed if ServerSettings.json is not valid Fixed 
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226939 - Server If Backup for LocalDB was set to On Service Startup and Job Retention was larger than 
0, the DatabaseCleaner did not stop running on service startup. 

Fixed 

227885 - Server New system JobInfo introduced, named ConfigRevision, to get the revision of the 
configuration. In the Developer app, the value is returned as 'Patched' unless an older 
revision is opened. Lasernet Service returns the deployed revision number. 

Enhanced 

226710 - Form Editor Grab function F12 did not load file into form as in Lasernet 9. Fixed 

224575 Freshdesk 
17913 

Form Editor The currency sign "¤" is supported as the ESC character for the hashmark sign "#" if the 
hashmark is a part of the string in a Fixed Text or a JobInfo value. 

Fixed 

227384 - Form 
Engine 

Barcodes were not loaded in EMF/PDF forms. Fixed 

- - Web Client The appsettings file was read from the wrong folder. Fixed 

223729 Freshdesk 
17951 

XML 
Transformer 

Search dialog did not remember checkmarks settings. Fixed 

259068 - OCR 
Engine 

Issue when loading multiple OCR Engines in a configuration. Fixed 

- - PDF Splitter Support for splitting PDF documents with barcodes not embedded as an image Fixed 

- - Scheduler 
Input 

Scheduler Input jobs did not start at the scheduled time. Fixed 

227138 - Web Server 
Input 

A ByteArray was not added as Base64 encoded string, but instead as an array of bytes. Fixed 
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Lasernet 10.0. 

Lasernet Launcher

• A new-look Lasernet Launcher. 

Lasernet License Manager

• A 'Client Secret' setting is now required and automatically generated 

when adding a new instance for Lasernet Server 10 to increase security 

for Lasernet applications. 

Microsoft SQL Server Express LocalDB

• To simplify the installation in a demo or developer environment, 

Lasernet is delivered with an embedded database as a backend by 

default. 

REST API with OpenID Authentication

• A new REST API and OpenID Authentication replaces the previous 

SOAP API and Basic Authentication in Lasernet 9 with a modern token 

or key-based approach. 

Lasernet Config 10

Lasernet Config 10 is updated with a new embedded web framework to 

manage: 

• Configurations 

• Users and Groups 

• Revisions 

• History 

• Deployments 

• Print Servers with settings for Azure Storage Account and Azure 

Service Bus for easy access to Cloud and On-premise printing. 

Lasernet Server

• Added new embedded web framework to manage configurations, users 

and groups, revisions, history, deployments and Print Servers settings 

for Azure Storage Account and Azure Service Bus.  
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Lasernet Developer

• Minor improvements in diagram mode. 

• Modules divided into five types of modifiers. 

• New resource folder to store cached Windows fonts.  

• Shortcut for send grab files to the input folder.  

• The list of Print Server names and Connection Strings are now retrieved 

from the list of Printer Servers added to the Lasernet Config 10 server.  

Lasernet Monitor 10

• A new desktop application with improved user experience, reduction in 

log traffic, a Performance Monitor and a REST API and OpenID 

authentication communicating with Lasernet Server 10 through the 

Lasernet Config 10 server. 

Lasernet Form Editor 10 (EMF/PDF)

• Easier styling of fonts in Insert Text objects (postponed until beta 

release). 

• Format painter usage for tables across forms in the configuration. 

• Removed reference printers’ settings in forms to avoid requirements to 

locally-installed printer drivers. 

• Support for Windows fonts to be loaded and stored in the Lasernet 

Configuration 

Lasernet Form Editor 10 

(DOCX/PDF/XLSX/HTML)

• Word control is enhanced to support more complex text processing, with 

text wrapping around tables, widow/orphan control in tables, break table 

rows across pages and shape enhancements. 

• Create HTML documents with mail-merge functionality, as known from 

Rich Text DOCX/PDF, with DataSet as input. 

Lasernet Client 10

• A new web front-end with a clean, flexible and intuitive user interface. 

• Optimized for Lasernet Input Management users. 

• A centralized web server installation, with a REST API and OpenID 

authentication, that communicates with Lasernet Server 10 through the 

Lasernet Config 10 server. 
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Lasernet OCR

• Improved calculation method for Statistics in Lasernet OCR Engine 10. 

The following modules are no longer supported by Lasernet from this 

version, Lasernet 10: 

• Barcode fonts running the Symbology Barcode Profile. 

• SAP BC-XOM Input module. 

• Microsoft Message Queue (MSMQ) Input and Output modules. 

• Google Cloud Printer Input and Output modules. 

• Microsoft Fax module. 

• DM Archive (replaced with the newer DM Upload). 

It is recommended that unsupported modules are removed from the 

workflow in older configurations before the import of a full configuration in 

Lasernet 10. 

• Due to a certificate update for all our Lasernet Installers, it might be 

expected that a Windows Defender SmartScreen dialog will pop up 

when running the installer. 

• Windows Defender SmartScreen prevented an unrecognized app error. 

This can happen when a program installer is new and is not yet 

recognized as safe by your system. You can work around this error by 

clicking the More info link and then clicking the Run anyway button. 

Barcode Reader

• A new modifier added to the Input Management package to read and 

extract barcode names and values from jobs. 

PDF Barcode Splitter

• A new feature in the PDF Splitter module for scanned pages in batch 

jobs separated by barcode. 

•  Support for UPC-A/E, EAN 8/13, Code 39/93, Codabar, QR Code, Data 

Matrix, PDF 417, MaxiCode, with the option for others. 

• The option to discard separate pages is supported. 

Tesseract OCR

• Improved workflow with built-in server module. 

• Faster OCR processing with multi-thread processing support. 

• Keep text in original PDF document to improve quality of extracted text 

and values for incoming documents. 
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• Easier deployment on new or existing servers. 

Auto Capture

• A new smart feature in the Lasernet Input Management solution has 

been added. 

 


